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EXECUTIVE SUMMARY

Introduction

With the Industry Foundation Classes (IFC) Building

Information Modeling (BIM) standard (ISO16739) being adopted

by the American Association of State Highway and Trans-

portation Officials (AASHTO) as the national standard for

modeling bridge and road infrastructure projects (AASHTO,

2019), there is an urgent need to upgrade the model development

standard of roads and related assets to 2D+3D BIM to fulfill the

integration of infrastructure projects data to comply with national

requirements. Example benefits of IFC-based modeling of roads

and related transportation assets include preserving accurate and

up-to-date asset information for lifecycle data needs, easier

collaborations between different stakeholders, and easier quality

assurance (QA).

Efforts have been made by different states to create BIM-based

model development standards such as the Ohio DOT Standards

for InRoads/CAD (Ohio DOT, 2021), the Utah DOT Model

Development Standards Manual (UDOT, 2023), and the Virginia

3D Model Development Manual (VDOT, 2020). However, the

BIM frameworks from other states cannot be directly applied to

the business at INDOT without testing, analysis, and customiza-

tion. A practical and implementable standard needs to be

customized to the current business practice and asset types of

INDOT. Furthermore, transitioning to a new model development

standard should be based on the existing project practice at

INDOT and take shape gradually. Therefore, how to build the

INDOT model development standard of roads and related assets

to reap the benefits of BIM technology while minimizing or

preventing potential business disruptions at INDOT is the

question to be addressed.

INDOT has recognized the need for integrating IFC-based BIM

into the life cycle management of roadway projects and related

transportation assets. In the previous SPR-4421 Life Cycle

Integration of Infrastructure Information Modeling project (Guo

et al., 2021a, b), several identified challenges in the current

INDOT process could benefit from BIM-based life cycle project

information management. Some examples of this include the

challenges in conflicting opinions about submitting 3D models as

legal documents, providing digital as-builts without disclaimer,

and the need for a better way to convert 3D models and geo-

graphic data between different formats (Guo et al., 2021b).

Follow-up discussions with INDOT led to the identification of an

immediate need for BIM-based model development standards for

drainage and concrete pavement. Correspondingly, specific

objectives of this study include the following.

1. Develop BIM-based model development standards for

drainage.

2. Develop BIM-based model development standards for

selected pavement components.

3. Develop an IFC-based QA method and tool.

Findings and Implementation

N An investigation of interoperability between OpenRoads

Designer, Civil 3D, respectively, and IFC was conducted. It

was found that all the tools could transform drainage and

concrete pavement models to IFC following certain paths.

All the drainage and concrete pavement components and

their properties could be converted without error.

N Even though OpenRoads Designer and Civil 3D could

transform drainage models to IFC successfully with different

approaches, the transformed IFC heavily used IfcBuilding

ElementProxy and IfcCourse at the time of the test. To better

distinguish drainage and concrete pavement components for

asset management or QA purposes, a new IFC modeling

standard needs to be established. The standard should

include all types of drainage and concrete pavement

components. For example, curb inlet, outfall, and conduit

may need to be represented by designated entities such as

IfcCurbInlet, IfcOutFall, and IfcConduit, respectively.

N To facilitate the development of the above-mentioned

standard, in this project, we initially drafted a Model

Development Instruction Manual for Drainage Inlet

(Appendix A) and a Model Development Instruction

Manual for Concrete Pavement (Appendix B).

N Until the above-mentioned standard is well established and

enforced, during the transition period, automated classifica-

tion algorithms can be used to help with QA. In our initial

development, invariant signatures-based automated object

classification algorithms achieved 91% accuracy in classify-

ing drainage components and 100% accuracy in classifying

concrete pavement components. Error analysis revealed that

improvement towards 100% accuracy will require more

balanced training data.

N The IFC-based drainage and concrete pavement models can

facilitate INDOT’s advancement/transition toward BIM-

based practice and support better asset management of

drainage and concrete pavement in the dimensions of

interoperability, collaboration, and asset data management.
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1. INTRODUCTION

With the Industry Foundation Classes (IFC) Build-
ing Information Modeling (BIM) standard (ISO16739)
adopted by the American Association of State Highway
and Transportation Officials (AASHTO) as the national
standard for modeling bridge and road infrastructure
projects, there is an urgent need of upgrading the model
development standard of roads and related assets to
2D+3D BIM to fulfill the integration of infrastructure
projects data to comply with the national requirements
(Alexa & Williges, 2022). Example benefits of IFC-
based modeling of roads and related transportation
assets include preserving accurate and up-to-date asset
information for lifecycle data needs, easier collabo-
rations between different stakeholders, and easier
quality assurance (QA) (Lombardo, 2019).

Challenges for integrating BIM in infrastructure
projects have been identified in a previous SPR-4421
Life Cycle Integration of Infrastructure Information Model-
ing project (Guo et al., 2021a, b) and corresponding
solutions are proposed. For example, there are varie-
ties of choices in software or tools on the market to use
for infrastructure modeling in design, construction, or
asset management, which may create interoperability
issues and the isolation of data transmission among
different stakeholders. To address it, an IFC-based
approach is proposed, which can provide a neutral,
open, transparent, and as a result more accessible
workflow throughout the life cycle of a project (Guo
et al., 2021a, b; Li et al., 2022). As promising as it is,
the IFC standard can still be adopted in different
ways, which, in turn, may hinder its support in BIM
interoperability between different software/processes,
because IFC schemas allow certain flexibility such as in
the use of IfcPropertySet to represent different types
of properties. To overcome such limitations of IFC in
supporting BIM interoperability, a scientific-based and
empirical data driven approach was used to discover
invariant signatures of AEC objects, which was defined
as ‘‘a set of intrinsic properties of the object that
distinguish it from others and that do not change with
data schema, software implementation, modeling
decisions, and/or language/cultural contexts.’’ (Wu
et al., 2021). The invariant signatures of AEC objects
are used together with IFC to help achieve the objec-
tives in this project.

2. PROBLEM STATEMENT

Efforts have been made at different states to create
BIM-based model development standards such as the
Ohio DOT standards for InRoads/CAD (Ohio DOT,
2021), the Utah DOT Model Development Standards
Manual (Draft final 7/17/2023) (UDOT, 2023), and the
Virginia 3D Model Development Manual (VDOT, 2020).
However, the BIM frameworks from other states
cannot be directly applied to the business at INDOT
without customization; a practical and implementable
standard needs to be customized to the current business

practice and asset types of INDOT. Furthermore,
transition to a new model development standard should
be based on the existing project practice at INDOT and
taking shape gradually. Therefore, how to build the
INDOT model development standard of roads and
related assets to reap the benefits of BIM technology
whereas minimizing or preventing potential business
disruptions at INDOT is the question to be addressed.
Correspondingly, this research will answer the follow-
ing questions.

1. How to develop BIM standards for drainage at INDOT?

2. How to develop BIM standards for concrete pavement
components at INDOT?

3. How to QA BIM models submitted by stakeholders?

3. RESEARCH OBJECTIVES

INDOT has recognized the need of integrating IFC-
based BIM into the life cycle management of roadway
projects and related transportation assets. In the pre-
vious SPR-4421 Life Cycle Integration of Infrastructure
Information Modeling project (Guo et al., 2021a, b),
several identified challenges in the current INDOT pro-
cess could benefit from a BIM-based life cycle project
information management, such as the challenges in
contrasting opinions about submitting 3D models as
legal documents, contrasting opinions about providing
digital as-builts without disclaimer, and needs of a
better way to convert 3D models and geographic data
between different formats (Guo et al., 2021b). Specific
objectives of this study include the following.

1. Develop INDOT BIM-based model development stan-
dards for drainage.

2. Develop INDOT BIM-based model development stan-
dards for selected pavement components.

3. Develop IFC-based QA method and tool.

3.1 Business Process

The highway design at INDOT has already been
utilizing design software with BIM support (e.g., the
ability to export to IFC formats). What is missing is the
BIM standard to guide the creation of the design model
in a way that will facilitate its usage in construction and
storage in asset management. For example, the type
of material and type of lining for pipe culvert are
important information that could be specified at the
design stage and/or collected during the construction
stage and stored in IFC data for future use. However,
current practice does not formally store this informa-
tion. Site surveying or observation would need to be
conducted when this information is needed later down
the road, the effort of which could have been saved if
the standard for storing this information was in place.
This need is even more evident for things that go
underground. With the IFC being established as the
national standard for bridges and roadway, IFC-based
BIM standard could be developed to support the life
cycle information storage and satisfy information need
of roadway and related transportation assets.

Joint Transportation Research Program Technical Report FHWA/IN/JTRP-2023/16 1



Figure 3.1 IFC infrastructure extensions (BuildingSMART, 2020).
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3.2 Technical Rationale

‘‘To evaluate whether BIM data fulfills data
exchange requirements, MVD-based checking should
be adopted to validate the accuracy of the IFC file (Lee
et al., 2018). An MVD consists of a sequence of specifi-
cation units referred to as concept, which includes a
blueprint of IFC entities, their attributes, relationships,
and properties (Venugopal et al., 2012). MVDs pin-
point portions of an IFC data structure supported
within a particular model view (See et al., 2012). One of
the main characteristics of an MVD is its reusability,
allowing these concepts to be continuously applied in
developing other specifications across several domains
(Lee et al., 2018). An MVD allows a user to declare the
necessary attributes and entity relationships for the
specific use of the IFC file such as quantity takeoff’’
(Akanbi et al., 2020) and structural analysis (Ren &
Zhang, 2021). In this project, we started with potential
use of MVDs to check compliance with INDOT IFC-
based BIM model development standards. Standards and
specifications for roadway and related assets’ construc-
tion drawings are well defined. For example, it is required
that a plan view of the structure showing ‘‘details for the
installation of structure drainage features, including strip,
sheet, edge, blanket, and underdrain systems, and
associated piping’’ be submitted at least 90 days before
starting construction (FHWA, 2014). These served as
useful input when developing the BIM model develop-
ment standard at INDOT (e.g., serving construction).
Another important source of information is existing BIM
or CAD model development standards at other states.
For example, UDOT model development standard
manuals stated that 3D solid needs to be provided to
represent drainage pipe (UDOT, 2023). Starting from
these information resources and considering specific
needs at INDOT, an initial BIM model development

standard for drainage pipe was drafted at INDOT. For
example, the drainage pipe model at INDOT should
include not only a 3D solid, but material types for the
pipe and its lining. Drainage pipe models that follow
these standards could then be created in different design
software such as Bentley OpenRoads and Autodesk
Civil3D to investigate their imports into IFC data,
especially which IFC version will be most suitable to
enforce at INDOT projects (Figure 3.1).

Although MVDs could potentially be used for
enforcing the BIM model development standards
(e.g., MVD for drainage construction) with INDOT
project stakeholders (e.g., designers, consultants, con-
tractors, asset management office), based on our
evaluation, the standard MVD checking tool IfcDoc
was insufficient for the needed QA purpose at INDOT,
customized computer tool was therefore developed to
ensure the specific needs of INDOT are satisfied using a
method similar to that in (Ren & Zhang, 2021). With
the BIM model development standards for drainage
and pavement components drafted in this project,
a computer program was developed to automatically
extract needed information from IFC-based BIM
models to help with QA of the models.

4. METHODOLOGY

According to the nature of highway and roads
projects, we divided the research into two parts
(drainage and concrete pavement) and worked on each
part step by step to achieve the research objectives, as
shown in Figure 4.1.

4.1 Part 1: Drainage

We first studied the current practices of drainage
modeling standards from different states’ Departments



Figure 4.1 Structure and strategy of the research divided into two main parts—drainage and concrete pavement—to achieve
research objectives.

TABLE 4.1
Practices of drainage modeling standards from different state DOTs (Li, Xue et al., 2023)

State DOT Text Visual Illustration LOD Software

Utah DOT (UDOT, 2023) Yes Yes Yes NA

Virginia DOT (VDOT, 2020) Yes Yes Yes InRoads

California DOT (California DOT, 2020) Yes No Yes Civil 3D, MicroStation

Delaware DOT (Del DOT, 2020) Yes No No InRoads

Illinois DOT (Illinois DOT, 2022) Yes No No GEOPAK

Iowa DOT (Iowa DOT, 2022) Yes No No GEOPAK

Oregon DOT (ODOT, 2022) Yes No No InRoads

South Dakota DOT (SDDOT, 2022) Yes No No InRoads

Connecticut DOT (CTDOT, 2023) Yes No No InRoads

New York State DOT (NYSDOT, 2022a) Yes No No InRoads

Joint Transportation Research Program Technical Report FHWA/IN/JTRP-2023/16 3

of Transportation (DOTs) through a literature review.
After that, the drainage modeling design process was
investigated using current drainage modeling software
in the market. And utilities in the software for drainage
modeling standards were investigated. Following that,
the interoperability between typical drainage modeling
software and IFC was studied. A portion of this section
was previously published in Li, H., Xue, X., Zhang, J.,
& Chen, Y. (2023a). IFC-based stormwater drainage
modeling to support BIM for infrastructure. 2023
ASCE International Conference on Computing in Civil
Engineering (i3CE 2023), ASCE, Reston, VA. Repub-
lished here with permission from the American Society
of Civil Engineers and content updates.

4.1.1 Study of Current Practices

The current practices of drainage modeling standards
from different state Departments of Transportation
(DOTs) were studied through a literature review (Table
4.1) (Li, Xue et al., 2023). Ten out of ten reviewed State
DOTs provided textual description, while only two out

of ten provided visual illustrations, and three out of ten
provided Level of Details (LOD) requirements. State
DOTs may also provide workspaces/templates for spe-
cific software. For example, the Utah DOT describes
its requirements for 3D drainage models in textual
documents with visual illustration (UDOT, 2022). The
Virginia DOT’s 3D drainage model requirement is
similar to that of the Utah DOT. However, it also
explicitly describes the use of InRoads in creating the
3D model (VDOT, 2020). The review shows that
different state DOTs are at different stages of adopting
BIM and IFC and have different requirements on 3D
models of drainages.

The visual illustration is helpful for providing more
detailed and vivid demonstrations about the require-
ment on 3D drainages. However, the majority of the
reviewed state DOTs do not provide visual illustrations
on 3D drainage models in their requirements. This
could be caused by concerns of unintended conse-
quences when conveying information or ideas that was
not intended to convey and/or putting unnecessary
constraints on contractors (Li, Xue, et al., 2023).



4.1.2 Drainage Modeling Workflow Analysis

4.1.2.1 Design workflow. Typical drainage modeling
software was investigated in terms of its workflow for
creating a drainage model and utilities for creating
modeling standards. Although InRoads, GEOPAK
and Civil 3D were mentioned the most by state DOTs’
drainage modeling standards, OpenRoads Designer
includes all of the capabilities of InRoads and GEOPAK
(CTDOT, 2023). It combines InRoads and GEOPAK
by providing a new 3D parametric modeling environ-
ment with the capabilities for roadway, drainage,
subsurface utilities, and site design (CTDOT, 2023).
Therefore, OpenRoads Designer 2021 and AutoDesk
Civil 3D 2021 were selected as the modeling software for
investigating drainage modeling workflow in this report.

It was found OpenRoads Designer 2021 and
AutoDesk Civil 3D 2021 follow very similar modeling
rules and workflows. There are five main components
of a storm drainage system, including curb inlet, outfall,
conduit, gutter, and catchment.

The drainage design process is usually carried out
following five steps: (1) set terrain, (2) place node, (3)
place conduit, (4) place gutter, and (5) place catchment
(FDOT, 2021a). The first step is to set the active terrain
on which the drainage model is to be built, which is
usually done by attaching a reference file to the model.
Then, nodes are placed to define drainage structure

points within the drainage network (FDOT, 2021a).
These nodes serve as placeholders to create drainage
components including the inlets, junctions, and out-
falls in the drainage systems accordingly (FDOT,
2021a). The third step is to create conduits. A conduit
is a linear component representing a path connecting
two nodes. Following that, gutters are created to
simulate bypass flow along the surface between nodes
(FDOT, 2021a). Finally, the catchments are created,
which can be used to compute peak discharges. The
computed discharge values will then be attached to the
nodes (FDOT, 2021a). The design processes from
OpenRoads 2021 and Civil 3D 2021 were found to be
very similar based on the authors’ investigation. Figure
4.2 shows the detailed workflow of drainage design in
Civil 3D 2021.

An example drainage model was then created in
OpenRoads 2021 following the previous five steps. The
overview of the model is shown in Figure 4.3.

4.1.2.2 Model validation. OpenRoads 2021 has its
internal model validation functionality. For example,
Figure 4.4 shows the validation results of the example
model. A conduit was found not to meet minimum cover
constraints by hydraulic validation. And a link was found
to have an adverse slope from hydraulic results. These
validation results can help the designer correct input data
(FDOT, 2021b).

Figure 4.2 Drainage design workflow using Civil 3D 2021 (FDOT, 2021a).
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Figure 4.3 Overview of example drainage model created in OpenRoads 2021 (FDOT, 2021b).

Figure 4.4 Validation results on the example model.
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One advantage of OpenRoads 2021 is that it has the
functionality of creating customized engineering stan-
dards for model checking and validation (FDOT, 2021b).
Figure 4.5 shows an example of an engineering standard
created in OpenRoads 2021. It checks all the conduits
with diameters less than or equal to 18 feet. Any conduits
satisfying this precondition in the model with construc-
tion length greater than 100 feet will prompt a warning
in the user notification as shown in Figure 4.6. This
customized engineering standard functionality can poten-
tially be used in creating modeling requirements in
different standards for OpenRoads models.

4.1.2.3 Simulation. Figure 4.7 shows profile run
results of Node S-203 to Node S-208 for the example
model created in OpenRoads 2021. The detailed
simulation results including the link length, rise (inch),
material, flow (CFS), slope (%), etc. for each conduit
are shown in Figure 4.7. Designers could use these
output data for drainage system component sizing and
developing flood control strategies.

4.1.3 Research on Interoperability

Interoperability between state-of-the-art drainage
design software (i.e., AutoDesk Civil 3D, 2021; Bentley,
2021) and IFC data schema was explored.

4.1.3.1 Bentley OpenRoads Designer. OpenRoads
2021 has its internal utility for exporting to IFC.
However, according to the authors’ test (and at the time
of test), it only allows exporting civil elements (i.e., the
terrain model and corridor where the drainage model is
built upon) without exporting drainage model. Figure
4.8 shows an example of OpenRoads model and corres-
ponding IFC model exported through the built-in export
utility. It can be seen that while stormwater management
facilities and civil elements were successfully transformed,
the drainage system (highlighted in the yellow bounding
box in Figure 4.8(a)) was missing from the transformed
IFC model (Figure 4.8(b)).

To export the drainage system from OpenRoads
2021 to IFC, the authors investigated other intermedi-
ate data formats and tools (FDOT, 2021b). It was
found that the conversion from Bentley OpenRoads
Designer drainage model to IFC can be done in four
steps with the support of iTwin Design Review
platform and iModel: Step 1. export as iModel from
OpenRoads Designer; Step 2. upload iModel to iTwin
Design Review platform (Figure 4.9); Step 3. select IFC
schema (supported version at the time of test: IFC 4.3
RC1, IFC 263, IFC 263 CV 2.0, IFC 4); and Step 4.
wait for processing and download the exported IFC file
from iTwin Design Review platform. Figure 4.10 shows
an OpenRoads drainage model and the corresponding



Figure 4.5 An example engineering standard created in OpenRoads 2021.

Figure 4.6 Example validation results for the created engineering standard in OpenRoads 2021.

Figure 4.7 Profile run results of Node S-203 to Node S-208 for the example model created in OpenRoads 2021.
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transformed IFC drainage model. All the drainage
components were transformed correctly. In addition,
the attributes and feature definitions under each
element were also transformed to IFC without error.

4.1.3.2 AutoDesk Civil 3D. Then, the interoperability
between AutoDesk Civil 3D 2021 and IFC was also
investigated. It was found the transformation takes four
steps: Step 1. convert to 3D Solid by extracting solid
object through Civil 3D surfaces; Step 2. add property

sets; Step 3. select IFC version and export options; and
Step 4. export to IFC. Figure 4.11 shows the interface for
converting drainage model to 3D Solid objects in Civil
3D. Figure 4.12 shows the converted 3D Solid model.

The second step is to add property sets to the
drainage elements. According to the authors’ test, attri-
butes of elements in Civil 3D could not be transformed
into IFC without creating property sets. There were two
approaches to create property sets. The first one was to
create property sets manually in Civil 3D. Figure 4.13



Figure 4.8 Example of exporting OpenRoads model (a) to IFC model (b).

Figure 4.9 Interface of iTwin design review.

Figure 4.10 OpenRoads drainage model (a) and transformed IFC drainage model (b).
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shows the interface for creating property sets in Civil
3D manually. The second approach was to create
property sets through programming and applications
such as using VB scripts.

Figure 4.14(a) shows the property sets of a drainage
component in Civil 3D and Figure 4.14(b) shows the
transformed property sets in IFC. It can be seen that all
the attributes in the property sets were transformed
correctly.

The next step was to select the IFC version and
export options as shown in Figure 4.15. At the time of
test, the available IFC versions included IFC 461, IFC
263, and IFC 4. By selecting the Solid 3D objects in
the export options and IFC 461 for the IFC schema,
the drainage model can be successfully exported from
Civil 3D to IFC.

Finally, the exported IFC model from the example
model created in Civil 3D 2021 is shown in Figure 4.16.



Figure 4.11 Interface for converting model to 3D solid in Civil 3D.

Figure 4.12 Converted 3D solid model.

Figure 4.13 Interface for creating property sets in Civil 3D.
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Table 4.2 summarized the interoperability between
state-of-the-art drainage modeling software and IFC.
Both Bentley OpenRoads Designer 2021 and Auto-
Desk Civil 3D 2021 can transform the storm drainage
model to IFC. At the time of test, OpenRoads Designer
relied on iTwin Design Review platform using
iModel, Civil 3D needed to convert drainage model
to Solid 3D objects first then exported it as IFC.
OpenRoads could convert all the attributes associated

with each drainage component directly without error.
While Civil 3D could not convert attributes directly,
it relied on property sets for transforming attri-
butes. Both OpenRoads Designer and Civil 3D
converted drainage models to IFC without distinguish-
ing IFC entity representations. All the drainage com-
ponents were transformed and represented as Ifc
BuildingElementProxy as highlighted in the red box in
Figure 4.17.



Figure 4.14 Property sets of drainage component in Civil 3D (a) and property sets of drainage component in IFC (b).

Figure 4.15 Interface for exporting Civil 3D to IFC.

Figure 4.16 Exported IFC model from Civil 3D 2021.
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TABLE 4.2
Tested interoperability between drainage modeling software and IFC

Software Platform Bentley OpenRoads Designer 2021 AutoDesk Civil 3D 2021

Transforming Process Relied on iTwin Design Review platform and

iModel

Needed to create Solid 3D objects for the drainage model

to be transformed

Component Attributes Could convert all the attributes directly without

error

Could not convert attributes directly. Relied on property

sets for transforming attributes

IFC Entity Representation No distinction in IFC representation of drainage

components. All the components were

represented as IfcBuildingElementProxy

No distinction in IFC representation of drainage

components. All the components were represented as

IfcBuildingElementProxy

Figure 4.17 Exported IFC drainage model with IFC entities.

Figure 4.18 Research method for investigating the concrete pavement components.
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4.1.4 Indiana Department of Transportation (INDOT)
Model Development Instruction Manual for Drainage
Inlet (Draft)

Based on results from previous tasks and extensive
discussions with study advisory committee (SAC), it
was decided the first component of INDOT model
development standards should be an instruction man-
ual for drainage inlet, which was then drafted as
detailed in Appendix A.

4.2 Part 2: Concrete Pavement

Figure 4.18 summarized the overall research app-
roach for the concrete pavement part. For concrete
pavement, through a literature review, we first studied
the current practices of concrete pavement components
standards from different state DOTs (as shown in Table
4.3). After that, the concrete pavement modeling design
process and software interoperability with IFC was

investigated using a current road modeling software
in the market (Bentley, n.d.). The functions in the
software for concrete pavement components’ modeling
standards were investigated based upon which a draft
model development instruction manual for concrete
pavement was created.

4.2.1 Study of Current Practices

According to (INDOT, 2022c), INDOT Pavement
Design Process - INDOT Projects Flowchart contained
details regarding the pavement design process, as
shown in Figure 4.19.

4.2.2 Research on Interoperability

IfcBuildingElementProxy is an Entity, as shown in
Figure 4.20 and Figure 4.21, that was defined as
‘‘a proxy definition that provides the same functionality
as subtypes of IfcBuildingElement, but without having



Figure 4.19 INDOT pavement design process—projects flowchart (INDOT, 2022c).

Figure 4.20 IfcEntity for IFC263 version.

Figure 4.21 IfcEntity for IFC4 version.
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Figure 4.22 IfcEntity for IFC463 version.

12 Joint Transportation Research Program Technical Report FHWA/IN/JTRP-2023/16

a predefined meaning of the special type of building
element, it represents.’’ (buildingSMART, n.d.a). Also,
IfcBuildingElementProxy can be for other usages that
include (buildingSMART, n.d.a) the following.

N ‘‘The IfcBuildingElementProxy can be used to exchange

special types of building elements for which the current

specification does not yet provide a semantic definition.

N The IfcBuildingElementProxy can also be used to

represent building elements for which the participating

applications cannot provide a semantic definition.’’

IfcCourse is an Entity, as shown in Figure 4.22, that
was defined as ‘‘a built element whose length greatly
exceeds its thickness and often also its width, usually
of a single material laid on site on top of another
horizontal or nearly horizontal built element.’’
(buildingSMART, n.d.b).

More detailed breakdowns of entities for represent-
ing objects in the different versions of the IFC schema
are shown in Figures 4.23–4.29.

4.2.3 Indiana Department of Transportation (INDOT)
Model Development Instruction Manual for Concrete
Pavement (Draft)

Similar to the Model Development Instruction Manual
for Drainage Inlet, a Model Development Instruction
Manual for Concrete Pavement was drafted, as detailed
in Appendix B.

4.3 QA Method and Tool Development

Based on extensive discussions with study advisory
committee (SAC), the primary goal of the QA is to
check and identify the different components in a model.

4.3.1 Drainage

For drainage model depicting a storm drainage
system, drainage components can be classified into
two main types: node elements and conduits. Node
elements include inlets, outfalls, grates, and junctions.
Conduits include pipes and gutters.

Based on the results from Section 4.1.3, there is a
prevalent use of IfcBuildingElementProxy entity to
represent different types of drainage components in
IFC models, which caused the direct MVD-based
approach ineffective in performing the needed QA on
IFC-based drainage models in this context. To address
this challenge, the authors took a cutting-edge invariant
signature-based approach. The invariant signature of
an architecture, engineering, and construction (AEC)
object is ‘‘a set of intrinsic properties of the object that
distinguish it from others and that do not change with
data schema, software implementation, modeling deci-
sions, and/or language/cultural contexts.’’ (Wu et al.,
2021). The invariant signatures include two main
types—geometric signatures and material signatures
(Wu, Akanbi, & Zhang, 2021), which have been success-
fully tested and demonstrated in supporting different
BIM-based applications such as automated quantity
takeoff from IFC-based BIM (Wu, Akanbi, & Zhang,
2022), automated BIM-based building code compliance
checking (Wu et al., 2023; Wu & Zhang, 2022; Wu,
Akanbi, & Zhang, 2022), and building energy modeling
and simulations (Li, Zhang et al., 2023; Li & Zhang,
2023; Li & Zhang, 2022).

Stormwater node elements include curb inlet, grate,
outfall, and junction. Geometric signatures of storm-
water node elements including invert elevation, ground
elevation, structure depth, etc. are summarized in Table
4.4. Examples of outfall, curb inlet and grate are shown
in Figure 4.30, Figure 4.31, and Figure 4.32, respec-
tively. Figure 4.33 shows the feature definition of a
grate and an inlet in Bentley OpenRoads.

‘‘Conduits connect and convey intercepted runoff
from the various Nodes within a network to the Outfall,
and may consist of pipes, boxes, or ditches. A multitude
of options for sizing, and profiling Conduits are sup-
ported. A Conduit represents a linear feature depicting
a path connecting two Nodes. The path may be a
straight line, line string, curvilinear, or a combination’’
(FDOT, 2021b). ‘‘Gutters are required to model bypass
flow along the surface between nodes. Typical applica-
tions of gutters in designs are Curb & Gutter, median
and adjacent barriers, and shoulder gutter’’ (FDOT,
2021b). Conduits include drainage pipes and gutters.
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TABLE 4.3
Example practices of pavement modeling standards from different state DOTs

State/Reference Design Criteria Pavement Design Software

UDOT

(UDOT, n.d.; UDOT, 2022)

Bentley View CONNECT: 10.16.02.22

MicroStation CONNECT: 10.16.02.34

OpenRoads Designer: 10.10.21.04

Virginia DOT

(VDOT, 2018b)

Effective Structural Number (SNeff)

Layer Moduli

Resilient Modulus of the Subgrade

Pavement Material Types

ThicknessVisual Condition

Elastic Modulus of the PCC

Composite Modulus of Subgrade Reaction

Load Transfer at Cracks and Joints and

Potential for the Presence of Voids

AASHTOWare Pavement ME

California DOT

(Caltrans, 2019, 2023)

MicroStation Connect

Civil 3D

Delaware DOT

(MediaWiki, 2021;

DelDOT, 2021;

DelDOT, 2019)

Design Speed (mph)

Travel Lane–Width (ft)

Travel Lane–Cross Slope (%)

Inside Shoulder–Width (ft)

Inside Shoulder–Cross Slope (%)

Outside Shoulder–Width (ft)

Outside Shoulder–Cross Slope (%)

Auxiliary Lanes–Width (ft)

Auxiliary Lanes–Cross Slope (%)

Median–Width (ft)

Minimum Horizontal Curve Radius (ft)

Superelevation Rate (%)

Stopping Sight Distance (ft)

Maximum Percent Grade (%)

Minimum K (Crest)

Minimum K (Sag)

Maximum Front Slope (Unprotected)

Maximum Back Slope

Clear Zone Width (ft)

Lateral Offset (ft)

Barrier Offset (ft)

Structural Capacity

Bridge Width (ft)

Vertical Clearance (ft)

MicroStation Connect

OpenRoads Designer

OpenBridge Modeler

ProStructures

Iowa DOT

(Iowa DOT, 2017, 2021)

Design Speed

Lane Width

Design Loading Structural Capacity

Shoulder Width

Horizontal Curve Radius

Superelevation Rate

Maximum Grade

Stopping Sight Distance

Cross Slope

Vertical Clearance

OpenRoads Designer

Geopak

MicroStation Connect

Oregon DOT

(ODOT, n.d.)

InRoads Design

OpenRoads Designer

South Dakota DOT

(SDDOT, 2023)

InRoads Design

MicroStation

Continued
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TABLE 4.3
(Continued)

State/Reference Design Criteria Pavement Design Software

Connecticut DOT

(CTDOT, n.d.)

Number of Lanes

Lane Width

Shoulder Width

Median Width

Climbing Lanes

Superelevation

Traffic Barriers and Guide Railing

Cross Slope

Pavement Depth

Pavement Composition

Curbing

Side Slopes

Sidewalks (Location and Width)

OpenRoads Designer

InRoads 8.5

MicroStation

New York State DOT

(NYSDOT, 2020; NYSDOT,

2022b)

Design Speed

Lane Width

Shoulder Width

Horizontal Curve Radius

Super Elevation

Stopping Sight Distance (Horizontal and Vertical)

Maximum Grade

Cross Slope

Vertical Clearance

Design Loading Structural Capacity

ADA Compliance

MicroStation Connect

OpenRoads Designer

OpenBridge Modeler

OpenBridge Designer

ProStructures

TABLE 4.4
Geometric signatures of drainage components (node elements)

Feature Inlet Outfall Grate Junction

Invert Elevation (ft) 24.5–28 25.75 25.16–28 27.12–27.13

Ground Elevation (ft) 30.2–33.95 29 32–33.8 32.7

Structure Depth (ft) 5–7.85 3.25 7.83–7.84 5.57–5.58

Width N/A N/A 3 N/A

Length N/A N/A 4.5 N/A

Grate Width N/A N/A 3.33 N/A

Grate Length N/A N/A 4.33 N/A

Diameter (m) 1.2192 N/A N/A 0.9144–0.9145

Longitude Slope +0.12%–0.81% N/A N/A N/A

Match Slope of Conduit No No No No

Curb Opening Length 13–20 N/A N/A N/A

Figure 4.30 Outfall IFC model.
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Figure 4.31 Curb inlet IFC model.

Figure 4.32 Grate IFC model.

Figure 4.33 Feature definition (left: grate; right: inlet) in Bentley OpenRoads.
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Typical geometric signatures of example conduits are
shown in Table 4.5. An example conduit in IFC is
shown in Figure 4.34.

4.3.1.1 Data collection. The drainage IFC models
were collected from HNTB, an American infrastructure
design firm. Two IFC models exported from Auto
Desk Civil 3D were leveraged to start developing the
QA tool. The IFC models were then loaded by
IfcOpenShell, an open-source IFC toolkit in Python
(IfcOpenShell, 2023). Invariant signatures including
frame type, diameter or width, floor thickness, height,
inner diameter or width, and inner length were extracted
through IfcOpenShell and organized into a table as
shown in Figure 4.35. There are 161 drainage elements in

total including inlets and manholes with 14 frame types.
Figure 4.36 shows the detailed inlet and manhole types
extracted from the IFC models.

4.3.1.2 Experiments and results. In the experiment,
Machine Learning (ML) models were used to train
classifiers to classify the frame type of inlets and
manholes as shown in Figure 4.36. The 14 inlet types
and manhole types were encoded into numerical labels
as shown in Table 4.6.

The 161 drainage elements were randomly divided
following the ratio of 80% / 20% for training and test-
ing, respectively. After that, three machine learning algo-
rithms were leveraged to train the classifier, which were
logistic regression, decision tree, and random forest,



respectively. The trained classifiers were then tested with
the testing data. The performance is shown in Table 4.7.

Then, additional invariant signatures were added in
the training to improve the classifier performance,

including pipe lowest bottom depth, pipe upper top
depth, rim elevation, and rim to sump height. The imp-
roved accuracy is shown in Table 4.8. It can be seen
that the classifier trained by the random forest
algorithm achieved a promising 91% accuracy.

4.3.1.3 Error analysis. Error analysis on the improved
random forest model was performed in this section.
Because the training and testing data were randomly
divided and the original data were not uniformly
distributed, the testing data only contained 7 frame
types, which were {3, 4, 5, 6, 9, 10, 13}, as shown in the
output of ‘‘ground_truth’’ in Figure 4.37. The predicted
results of the trained model were shown in the output of
‘‘predicted_results’’ in Figure 4.37.

A confusion matrix was plotted and utilized to carry
out error analysis as shown in Figure 4.38. The result-
ing confusion matrix is a 767 array, where each row
‘‘represents the instances in a predicted class, and each
column represents the instances in an actual (true)
class,’’ (Giommi, 2023) in the order of {3, 4, 5, 6, 9, 10,
13}. The matrix is populated with instance counts, so
the value in each cell represents the number of instances
that were predicted to belong to the corresponding row
class and actually belonging to the corresponding

TABLE 4.5
Geometric signatures of example conduits

Feature

Conduit

Pipe Gutter

Start Node S-104 S-211

Stop Node S-105 S-212

Start Invert (ft) 29 27.1

Stop Invert (ft) 28.6 26.9

Shape Circle Circle

Slope (calculated/construction) +0.37% / +0.4% +0.39% / +0.43%

Length (unified/construction) (ft) 107.73/101.01 51/47

Single Gradient True True

Number of Barrels 1 1

Figure 4.34 Node S-104, S105, and the conduit connecting
them.

Figure 4.35 Data collected from drainage IFC models (partial).

Figure 4.36 Inlet and manhole types.
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column class. The diagonal elements of the confusion
matrix represent the number of true positives for each
class. Off-diagonal elements represent the number of
misclassifications. For example, the confusion matrix
shows that for frame type 3 (Inlet Type P-12), there are
14 correctly classified instances (true positives). There
are 3 elements wrongly classified in total. The ‘‘1’’ in the

2nd row and 3rd column (as shown in the green box in
Figure 4.38) indicates that there is one instance that is
frame type 5 (Inlet, Type C-15) but wrongly classified as
type 4 (Inlet, Type B-15). A potential cause of this error is
that inlet Type C-15 and Type B-15 have very similar
values in their invariant signatures. For example, they
both have a height of around 4 to 5 inches and an inner
diameter of 2.5 inch. That will cause the model more
difficulty to learn and distinguish between them due to
their high similarity. That issue could be solved by
collecting more data. Another potential cause is the noise
in the data, which can cause the model inability to learn
the underlying patterns accurately because there are
random errors or outliers, leading to misclassifications.

The ‘‘1’’ in the 3rd row and 4th column (as shown in
the orange box in Figure 4.38) indicates that there is
one instance that is frame type 6 (Inlet, Type E-7) but
wrongly classified as type 5 (Inlet, Type C-15). In the
collected data, the number of instances in type 5 is
significantly more than that in type 6. That could cause
model underfitting in classifying type 6 because the
model is too simple and is unable to capture the under-
lying patterns from the limited data. This issue could
also lead to misclassifications.

TABLE 4.6
Types and labels of conduits

Frame Type Numerical Label

Curb Inlet 0

Inlet Type E-7 1

Inlet Type E-7, Modified 2

Inlet Type P-12 3

Inlet, Type B-15 4

Inlet, Type C-15 5

Inlet, Type E-7 6

Inlet, Type F-7 7

Manhole Type F-4 Mod 8

Manhole, Type C-15 9

Manhole, Type C-4 10

Manhole, Type C-7 11

Manhole, Type J-4 12

Rectangular Junction Structure NF 13

TABLE 4.7
Trained classifiers and their accuracy

ML Algorithm Accuracy (%)

Logistic Regression 54

Decision Tree 81

Random Forest 78

TABLE 4.8
Trained classifiers and their accuracy after adding additional
invariant signatures

ML Algorithm Accuracy (%)

Logistic Regression 57

Decision Tree 82

Random Forest 91

Figure 4.37 Ground truth labels and the predicted labels.

Figure 4.38 Confusion matrix.
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The ‘‘1’’ in the 7th row and 1st column (as shown in the
purple box in Figure 4.38) indicates that there is one
instance that is of frame type 3 (Inlet Type P-12) but
wrongly classified as type 13 (Rectangular Junction
Structure NF). One of the potential cause of this error
is the imbalanced data. The most common inlet types are
Type B-15, C-15, and P-12. There is only one instance of
type 13 (Rectangular Junction Structure NF) in the
collected data. If the data is imbalanced, meaning that
the model will not learn enough information about the
minority class, which may lead to misclassification.

To summarize, the errors were mainly due to noise and
imbalance in the data. The performance can be improved
with more training data that is better balanced.

4.3.2 Concrete Pavement

For concrete pavement, four invariant signature
features were extracted from the two IFC pavement
models, which are volume, surface area, planar area,
and top slope area, respectively, as shown in Table 4.9.
There are four pavement layer types as shown in Table
4.10. To distinguish the layer types, machine learning
models (logistic regression and random forest) were
used to train a classifier based on the 4 invariant
signatures, which achieved 100% accuracy. An example
IFC pavement model is shown in Figure 4.39.

TABLE 4.9
Data collected from pavement IFC models

Layers Volume (ft3) Surface Area (ft2) Planar Area (ft2) Top Slope Area (ft2)

Aggregate Type A Base Course 139 2,858 1,301 1,302

Aggregate Type B Base Course 199 2,979 1,307 1,308

Aggregate Type A Base Course 139 2,863 1,304 1,304

Aggregate Type B Base Course 665 9,096 4,365 4,366

Aggregate Type B Base Course 200 2,985 1,310 1,310

Aggregate Type B Base Course 665 9,088 4,361 4,362

Concrete Pavement 1330 17,820 8,725 8,727

Curb 137 2,200 758 913

Curb 137 2,196 757 912

Aggregate Type A Base Course 931 17,711 8,725 8,727

Aggregate Type B Base Course 665 9,088 4,361 4,362

Aggregate Type B Base Course 498 6,905 3,268 3,271

Aggregate Type B Base Course 665 9,096 4,365 4,366

Concrete Pavement 443 6,179 2,905 2,907

Aggregate Type B Base Course 499 6,922 3,276 3,279

Concrete Pavement 444 6,193 2,912 2,914

Aggregate Type A Base Course 349 6,812 3,276 3,279

Concrete Pavement 1330 17,820 8,725 8,727

Aggregate Type A Base Course 349 6,796 3,268 3,271

Aggregate Type A Base Course 931 17,711 8,725 8,727

Figure 4.39 An example pavement model (partial).
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TABLE 4.10
Pavement component types

Component Type Numerical Label

Aggregate Type A Base Course 0

Aggregate Type B Base Course 1

Concrete Pavement 2

Curb 3

5. SUMMARY AND RECOMMENDATIONS

5.1 Summary and Findings

In this study, drainage and concrete pavement
modeling standards from different state DOTs were
reviewed and compared. It was found the most
frequently referenced software for drainage and con-
crete pavement modeling is InRoads and GEOPAK.
However, Bentley OpenRoads Designer was selected
for investigation in this study because they incorporate
the capabilities of InRoads and GEOPAK. Investi-
gation on interoperability of OpenRoads Designer and
Civil 3D, respectively, with IFC was conducted. It was
found both tools could transform drainage and
concrete pavement models to IFC following certain
paths. All the drainage and concrete pavement compo-
nents and their properties could be converted without
error.

Even though OpenRoads Designer and Civil 3D
could transform drainage models to IFC successfully
with different approaches, the transformed IFC heavily
used IfcBuildingElementProxy, at the time of test. To
better distinguish drainage and concrete pavement
components for asset management or QA purposes,
a new IFC modeling standard for drainage needs to be
established. The standard should include all types of
drainage and concrete pavement components. For
example, curb inlet, outfall, and conduit may need to
be represented by designated entities such as Ifc
CurbInlet, IfcOutFall, and IfcConduit, respectively.

To facilitate the development of the above-men-
tioned standard, in this project, we initially drafted a
Model Development Instruction Manual for Drainage
Inlet (Figure 5.1 and Appendix A) and a Model Develop-
ment Instruction Manual for Concrete Pavement (Figure
5.2 and Appendix B).

Until the above-mentioned standard is well estab-
lished and enforced, during the transition period,
automated classification algorithms can be used to
help with QA. Such algorithms can take the properties
or features of the component as input and output the

type of the drainage and concrete pavement compo-
nent. Related foundational research can be found in
(Wu & Zhang, 2019), where invariant signatures were
used to develop an algorithm for AEC object classifica-
tion. Their classification algorithm achieved 100%

precision and recall in correctly classifying 1,891 AEC
objects using the geometrical invariant signatures (Wu
& Zhang, 2019). In our initial development and
experiment in this SPR-4625 project, invariant signa-
tures-based automated object classification algorithms
have achieved 91% accuracy in classifying drainage
components and 100% accuracy in classifying concrete
pavement components. Error analysis revealed that
improvement towards 100% accuracy require more
training data that is balanced.

The IFC-based drainage model can facilitate
INDOT’s advancement/transition toward BIM-based
practice and support better asset management of
drainage and concrete pavement design in at least the
following three dimensions. (1) Interoperability: IFC
standards facilitate interoperability between different
software applications used for designing drainage and
concrete pavement models. Data can be easily shared
between software applications, reducing errors and
rework (Li & Zhang, 2023). (2) Collaboration: IFC
standards promote collaboration between different
stakeholders involved in the design, construction,
and maintenance of drainage and concrete pavement
models. This means that different stakeholders can
work together more effectively to create better designs
and manage assets more collaboratively (Li et al.,
2022). (3) Data management: IFC standards provide
a structured way of managing comprehensive data
related to drainage and concrete pavement models. This
means that data can be more easily stored, retrieved,
and updated in a consistent and timely manner (Li
et al., 2022).

5.2 Recommendations and Implementation

N In this project, model development instruction manuals

for drainage and concrete pavement were initially

drafted. These documents can be pilot tested with

INDOT design office, contractors, and consultants to

evaluate their easiness of use and level of detail

incorporated. Built upon feedback from pilot testing,

these manuals can be refined and expanded towards

more types of infrastructure components.

N For immediate QA needs during the transition period,

the invariant signature-based QA tool developed in this

project can be used, because it overcame the challenge

Figure 5.1 Companion documents to the INDOT Model Development Instruction Manual for Drainage Inlet (Draft).
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Figure 5.2 Companion documents to the INDOT Model Development Instruction Manual for Concrete Pavement (Draft).
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caused by the use of non-distinguishing IFC entities (e.g.,
IfcBuildingElementProxy). This QA tool was initially
tested by INDOT Management Information Systems
(MIS) successfully. For the long term, the IFC-based
model development standards will be able to and should
include more distinguishing IFC entities as they gradu-
ally become available from exports of various BIM
authoring tools.

N With maturing model development standards as
described above, seamless interoperability with IFC
model will become closer to reality. It is expected that
the IFC-based drainage and concrete pavement models
can better support the integration of BIM for infra-
structure projects, helping improve asset management
and QA processes at the state DOT level in terms of
efficiency and accuracy.

5.3 Expected Benefits and Cost Savings

With the above research findings, the following
benefits can be achieved.

The adoption of the model development instruction
manuals can help INDOT design office and consultants
save time and cost in the design process, as the standard
prototype components can be reused through drag-and-
drop.

The adoption of the QA tool can help INDOT
manage the quality of model submissions in a more
efficient way, reducing the need of manual checking
and therefore reducing the staff labor as well as the
turnaround time for such checking.

The above deliverables will facilitate the adoption of
BIM technology in roads and related transportation
assets at INDOT, where it saves time, cost, improve
productivity, helps decision makers with easy-to-access
project data and information throughout the life cycle
of an infrastructure project. The researchers and
practitioners interested in BIM for roads and related
transportation assets could also use the outcomes of
this study to inform further research and development.
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APPENDIX A. INDIANA DEPARTMENT OF TRANSPORTATION 
(INDOT) MODEL DEVELOPMENT INSTRUCTION MANUAL FOR 
DRAINAGE INLET (DRAFT) 

The deliverables for drainage information may include plan and profile drawing sheets, CAD 
reference files, GIS databases, 3D drainage models and associated drainage modeling reports 
(ASCE, 2022). In this document, drainage model (inlets) in OpenRoads is explored. 

A Subsurface Utility Engineering (SUE) deliverable “contains contiguous utility segments at any 
utility quality level, in any combination, depending on the scope of work of the utility investigation 
and the achieved utility quality levels. Utility quality levels may be developed and delivered in 
any order, or contemporaneously, as the project progresses through project delivery” (ASCE, 
2022). The dgnlib file in OpenRoads is one example of the SUE file. 

A.1 Definitions in OpenRoads

WorkSpace 
“A WorkSpace is a set of standards (e.g., Metric, Imperial, UK, ANZ, India Roads). These 
standards contain different Level naming, Road templates, superelevation calculations etc. When 
you select the WorkSpace, you are selecting the standards you want to use in a project or job” 
(Marnell, 2019). Therefore, the workspace of a specific DOT contains resources, standards, and 
tools necessary for designing projects in accordance with the Standards to that DOT (CODOT, 
2023). 
Catalog, prototype, and feature definition 
“In OpenRoads, Catalogs are an efficient way to reuse common physical definitions for inlets, 
conduits, and gutters. Catalog items can be imported from and exported to engineering libraries. 
Catalogs are loaded by Prototypes, which are loaded by feature definitions” (FDOT, 2021b). 

A.2 OpenRoads File Types

1. DGN Library (*dgnlib)
“The feature definitions, symbology, and hydraulic seed data for drainage design and modeling 
are stored in DGN libraries. The DGN Library is utilized for numerous projects, as it contains the 
standards for an entire organization. The DGN Library contains the storm data, hydraulic settings, 
standard inlet types, standard pipes configurations, spread sections, and land cover tables. These 
items are used by each project to accommodate standardization and information sharing among 
projects. The Department provides a DGN Library with the CADD deliverables” (FDOT, 2021b). 

2. MicroStation Design File (*dgn)
“This file is utilized for the visualization of the drainage project and definition of certain drainage 
features using MicroStation graphic elements. When the designer initiates the drainage & utilities 
tools, the DGN Library hydraulic seed data will be referenced by the design file. Subsequently, as 
drainage components are placed, the DGN model automatically populates hydraulic properties 
from the DGN Library and drainage structure geometry from the Cell Library into the design file. 
All the design data is stored within the design dgn file and database attributes are attached to the 
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2D graphics. As the designer places components in the 2D model, drainage & utilities creates the 
3D model elements in the dgn simultaneously” (FDOT, 2021b). 

A.3 Set OpenRoads Library 

1. Create New WorkSpace 
2. Create New WorkSet 
3. Create New .dng file 
4. Go to File -> Settings -> Configuration -> Configuration Variables 

 

 
Figure A.1 Interface of setting configuration variables. 

 
5. Create new variable named “SUDA_SEED_FILE” and set the new value (path) as the 

path of the “INDOT_SUE_Drainage.dgnlib” file. 
Or 
 
 “$(CIVIL_ORGANIZATION_STANDARDS)Dgnlib\Feature 
Definitions\FDOT_SUE_Drainage.dgnlib.” 
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Figure A.2 Set SUDA_SEED_FILE. 

 
6. Create new variable named “SUDA_SEED_MODEL” and set the new value (path) as 

“Default.” 
 

 
Figure A.3 Set SUDA_SEED_MODEL. 

7. Click “OK.” 
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Figure A.4 Interface of configuration variables. 

8. Go to Drainage and Utility -> Components -> Catalog. Now you should be able to access 
all the drainage catalog in the library. 

A.4 Import XML Library 

1. Go to Inlet Catalog -> Synchronization Option -> Import from Library. 

 
Figure A.5 Interface of importing xml library. 
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2. Add existing Library, select the “INDOT Inlet Library.xml” file. 

 
Figure A.6 Interface of engineering library. 

3. Import the inlet catalog (concrete inlet type U and W) from the library. 

 
Figure A.7 Interface of importing INDOT standard drainage inlet models. 

A.5 Three Steps of Creating/Importing a New Inlet  

1. Create inlet catalog. 
2. Create inlet prototype, link to the inlet catalog. 
3. Create feature definition, link to the inlet prototype. 
4. Create a new inlet model using the newly created feature definition. 
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Step 1. Create inlet catalog. 

 
Figure A.8 Detailed drawing of concrete inlet type U from INDOT standard (INDOT, 2022b). 

 
Figure A.9 Created inlet catalog of concrete inlet type U. 

Step 2. Create inlet prototype. 
 

1. Go to Component -> Catalog -> Prototypes. 

 
Figure A.10 Interface of creating prototypes. 
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2. Under “Catch Basin”, click “new” to create a new prototype. 

 
Figure A.11 Create a new inlet prototype under the catch basin category. 

3. Rename the newly created prototype to the desired name (“Concrete Inlet Type U” as 
shown in Figure A.12 as an example). Then double-click it to modify it. Under “Inlet”, 
select “Inlet Type” as “Catalog Inlet” and “Inlet” as “Concrete Inlet Type U” (the one 
imported from dgnlib). Then, the prototype is created. 

 
Figure A.12 Interface of creating the prototype of concrete inlet type U. 
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Step 3. Create feature definition. 
1. Click Home -> Explorer -> OpenRoads Standards -> Feature Definitions -> Node -> 

StormWaterNode. Right-click it and select “New Feature Definition” to create a new 
feature definition under the subfolder. The detailed steps are illustrated in Figure A.13. 

 
Figure A.13 Detailed step for creating a new feature definition for the stormwater node (inlet). 
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2. Right-click the newly created feature definition, select “edit feature definition”, then select 
“Concrete Inlet Type U” as its prototype as shown in Figure A.14. The new feature 
definition is then completed. 

 
Figure A.14 Interface of creating the new feature definition for concrete inlet type U. 
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Step 4. Create a new inlet model using the newly created feature definition. 
Firstly, we need to import reference terrain data. Go to Home -> Attach Tools -> References -> 
Tools -> Attach and select “reference.dgn”. Then click “OK”.  

 
Figure A.15 Steps to import reference data. 

 
Then, if you click on the “Fit View” button as shown in Figure A.16. You can see the reference 
terrain data as shown in Figure A.17. 
 

 
Figure A.16 Fit view button. 

 

 
Figure A.17 Overview of reference background data. 
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Then, we can place the inlet model. Go to Layout -> Place Node, click on it. In the popped-out 
window, select “inlet type U” as the feature definition, as shown in Figure A.18. Then you can 
place a new inlet model on the terrain.  
 
 

 
Figure A.18 Interface of creating a new inlet model. 

 

 
Figure A.19 Created inlet model of concrete inlet type U and W. 
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To create a 3D view of the model, click on the “2D Metric Design” at the bottom of the interface 
and select “2D Metric Design-3D Views” (as shown in Figure A.20 Steps 1 and 2). Then, select 
the “Rotation View” at the top of the interface (as illustrated in Step 3) and drag your mouse to 
change the angle of view in 3D perspective. Figure A.21 shows the 3D view of the created concrete 
inlets type U and W. 

 
Figure A.20 Steps for creating 3D view of the model. 

 

 
Figure A.21 3D view of concrete inlets type U and W. 
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APPENDIX B. INDIANA DEPARTMENT OF TRANSPORTATION 
(INDOT) MODEL DEVELOPMENT INSTRUCTION MANUAL FOR 
CONCRETE PAVEMENT (DRAFT) 

B.1 Design and Analysis

Pavement design is “the process of selecting a practical and economical combination of materials 
of known strength and adequate thicknesses to support anticipated traffic under the prevailing 
environmental conditions. Pavement will be designed following the appropriate procedures noted 
in this document” (VDOT, 2018a).  

Figure B.1 Pavement design workflow. 

FHWA Pavements and Materials Program Areas according to the Federal Highway Administration 
(FHWA, 2023):  

• Pavement Design
• Materials
• Quality Assurance
• Pavement Construction
• Pavement Management
• Pavement Rehabilitation & Preservation
• Sustainable Pavements

Select material, subbase, and base material (aggregate-type material). 
For rigid pavements, the Pavement designer will determine (VDOT, 2018a): 

• Elastic Modulus of the PCC.
• Composite Modulus of Subgrade Reaction.
• Load Transfer at Cracks and Joints.
• Potential for the Presence of Voids.

Data and Design Integration

Detailed Road Design

Drainage and Utilities

2D, 3D, Beyond 
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Figure B.2 Layers of concrete pavement (adapted from Kar et al., 2020). 

Proposed Full Depth Roadway Typical Section (VDOT, 2018a). 
• Length (ft) 
• Number of Lanes  
• Paved Lane Width (ft) 
• Right Total Shoulder Width (ft) 
• Left Total Shoulder Width (ft) 
• Right Paved Shoulder Width (ft) 
• Left Paved Shoulder Width (ft) 
• Paved Shoulder Type 
• Curb and Gutter Required 
• Length of c & G (ft) 
• % of New Horizontal Alignment 

 
Pavement Design Considerations according to Federal Highway Administration (FHWA, 2020). 

 
Figure B.3 Factors that affect pavement design (Johnson & Carrion, 2021). 
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Figure B.4 Materials of pavement. 

According to (FHWA, 2018a): “Evaluate the following design controls to understand the factors 
influencing the design and to determine the applicable criteria for establishing the standards for 
the project: 

• contextual factors and environmental constraints, 
• functional classification, 
• topography within the corridor,  
• location (i.e., rural or urban), 
• existing and expected traffic volumes and composition (e.g., ADT), 
• level of service and mobility, 
• level of access and management, 
• cross-section type and level of multi-modal accommodation, 
• existing and expected users and their characteristics, 
• superelevation rate, 
• existing and expected speed characteristics,  
• appropriate design speed, 
• existing and expected safety performance, and 
• other technical factors (geotechnical, hydraulic, pavement, structural, etc.).” 

According to FHWA (2018b), “for all projects, document the selection of applicable design criteria 
from approved standards, and when approved standards are not attained, document all exceptions.” 
All 13 principal design elements are considered controlling criteria, and the 4 supplemental 
standards require formal approval and documentation each time they are not attained. The 13 
principle controlling criteria are the following:  

• design speed, 
• lane width, 
• shoulder width, 
• bridge clear roadway width, 
• horizontal curvature, 
• vertical curvature, 
• gradient, 
• stopping sight distance, 
• normal travel lane cross slopes (crown), 
• superelevation, 
• structural capacity, 
• horizontal clearance to structures (tunnels and bridge underpasses), and 
• vertical clearance. 
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The four supplemental standards are the following: 
● clear zone,
● barrier crashworthiness,
● design flood, and
● pavement design service life.”

According to NYSDOT (NYSDOT, 2022), design criteria are influenced by the following: 
• The highway functional classification;
• Traffic volumes (from all surface, highway, and transit modes);
• Operating speed;
• Terrain (level, rolling, mountainous);
• Development density and land use; and
• Project type (e.g., new construction, reconstruction, 3R, 2R - simple 3R projects)

The design criteria (DelDOT, 2022) are shown in Table B.1.

Table B.1 List of design criteria (DelDOT, 2022) 
Design Criteria 
Design Speed (mph) 
Travel Lane - Width (ft) 
Travel Lane - Cross Slope (%) 
Inside Shoulder - Width (ft) 
Inside Shoulder - Cross Slope (%) 
Outside Shoulder - Width (ft) 
Outside Shoulder - Cross Slope (%) 
Auxiliary Lanes - Width (ft) 
Auxiliary Lanes - Cross Slope (%) 
Median - Width (ft) 
Minimum Horizontal Curve Radius (ft) 
Superelevation Rate (%) 
Stopping Sight Distance (ft) 
Maximum Percent Grade (%) 
Minimum K (Crest) 
Minimum K (Sag) 
Maximum Front Slope (Unprotected) 
Maximum Back Slope 
Clear Zone Width (ft) 
Lateral Offset (ft) 
Barrier Offset (ft) 
Structural Capacity 
Bridge Width (ft) 
Vertical Clearance (ft) 
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Figure B.5 Summary for design criteria with software and references. 

According to (VDOT, 2018a), the preliminary pavement evaluation, as shown in Figure B.6, 
includes the following tasks: 

• Task 1: Data Gathering. 
• Task 2: Field Data Collection. 
• Task 3: Preliminary Recommendation. 
• Task 4: Determine the Need for Detailed Pavement Evaluation. 

 

Design’ Criteria 

Design Type

Pavement Type

Concrete Layers & 
Thickness

Layers & Thickness

Base Thickness

Sub-base Thickness

Wheel load

Material Properties

Software

AASHTOWare Pavement 
ME Design

Civil 3D

MicroStation Connect

OpenRoads Designer

OpenBridge Modeler

ProStructures

InRoads Design

References
National Concrete 

Pavement Technology 
Center

American Concrete 
Pavement Association

Federal Highway 
Administration (FHWA)

AASHTO
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Figure B.6 Detailed pavement evaluation process flow (VDOT, 2018a). 

 

 
Figure B.7 Pavement types (VDOT, 2018a). 

 

Pavement Types

Flexible pavement Asphalt pavement

Rigid pavements 

Jointed Plain 
Concrete Pavement 

(JPCP)

Jointed Reinforced 
Concrete Pavement 

(JRCP)

Continuously 
Reinforced Concrete 

Pavement (CRCP) 

Composite pavements
(Asphalt over concrete 
surface is typical in VA)
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Design Procedures: Two design approaches can be used as follows (VDOT, 2018b): 
 

 
Figure B.8 Design methods for rigid pavement (VDOT, 2018b). 

 
Figure B.9 Details for the conventional pavement design method (VDOT, 2018b). 

Conventional Pavement Design Method

The evaluation of design variables
•The traffic in terms of projected Annual Average Daily Traffic (AADT)
•The soil support value of the subgrade

Design considerations
•Determination of the required Thickness Index of the pavement 
•The selection of paving materials based on the sum of the products of their thickness and 
thickness equivalencies equaling or exceeding the required Thickness Index value. 

Alternate Pavement Design Method

Conventional Pavement Design Method

•The thickness shall be rounded up to the nearest 0.5 inches
•Concrete shall be Class A-3 paving concrete according to the current Road and Bridge 
Specifications and appropriate supplemental specifications

•The pavement shall be Plain Jointed Portland Cement Concrete with a designed 
transverse joint spacing not to exceed 15 feet (the joint spacing in feet shall not exceed 2 
times the pavement thickness in inches). 

•Non dowelled pavement 6” or less in thickness, shall have at least 3 longitudinal joints 
(no joint along the wheel path), shall have maximum aspect ratio of 1:1 (length to width) 
and shall have maximum panel size of 8 feet by 8 feet. Continuously Reinforced Concrete 
Pavement may be considered an acceptable option. 

•In the case of very weak or very low resiliency soils having CBR values less than 2, the soil 
should be stabilized for a depth of six (6) inches with cement, 10% - 12% by volume, or in 
accordance with a detailed geotechnical design which the developer shall submit with the 
design documents for each new subdivision street. 

Alternate Pavement Design Method
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Figure B.10 Details for the alternative pavement design method (VDOT, 2018b). 

Table B.2 Layers’ details according to the alternative pavement design method (VDOT, 2018b) 

Design AADT Minimum Slab 
Thickness 

Minimum Aggregate 
Thickness 

Maximum Transverse 
Joint Spacing 

0-400 5 inches 6 inches 8 feet 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Alternate Pavement Design Method

Slab: A Minimum thickness of 5 inches non doweled, jointed plain concrete 
pavement shall be used.
Materials: Class A-3 concrete shall be used.
Base: A minimum of 6 inches aggregate base (21B) shall be used.
Joints: The subdivision street shall use minimum three (3) longitudinal joints within 
the road width. Longitudinal joints shall not be located in the wheel path. Joints will 
be sealed using hot pour asphalt or other approved joint sealant materials.
Paneling: Panels will be created using an aspect ratio of 1:1. The maximum panel size 
shall be 8 feet by 8 feet. 
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B.2 OpenRoads Designer 

Figure B.11 shows a map for supporting DOTs using Bentley GEOPAK/InRoads V8i and 
Autodesk Civil 3D (EnvisionCAD, 2021). 

 
Figure B.11 A map for supporting DOTs’ BIM for infrastructure (EnvisionCAD, 2021). 

Building Information Modeling (BIM) for Infrastructure (FHWA, 2021):  
“Many State Departments of Transportation (DOTs) recognize the benefits associated with the 
bigger picture of BIM as a data-centric approach for project delivery and asset management 
practices.” (FHWA, 2021). 
“The objectives of the FHWA BIM for Infrastructure program are to do the following. 

1. Describe BIM for Infrastructure and educate stakeholders. 
2. Share the implementation of BIM-related technologies and practices of the State DOTs. 
3. Help State DOTs identify steps to move from one maturity level to the next for a specific 

area.” (FHWA, 2021). 
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Figure B.12 FDOTCONNECT design and 3D modeling overview (FDOT, 2021). 

 Feature Definitions 
As defined in the Bentley Civil Tools help files (Bentley, 2021) (FDOT, 2021):  
“Feature Definitions are used to control symbology, annotation, and various other properties that 
are applied to the geometric elements. The feature definitions are used to:  

• Define what the geometric elements actually are. For example, what is being modeled, 
such as curb, centerline, pavement edge, etcetera.  

• Control symbology in various views, including the capability to define differing 
symbology in a plan, profile, and 3D spaces. 

• Define terrain modeling attributes (spot, break line, void, etcetera). 
• Define surface display characteristics.” 

 
 Civil Geometry - Design Intent 
As defined in the Bentley Civil Tools help file (FDOT, 2021):   
“Design intent builds associations and relationships between civil elements. Object information 
(how, where, and by what method it was created) is stored with the object to ensure the original 
intent is retained and honored in the design. Any related elements will recreate themselves based 
on these stored relationships if an element is modified.” 
 
 Design Standards  
Also known as Design Geometrics and Criteria and as defined in the Bentley Civil Tools help files 
(FDOT, 2021):   
“Design standards can be used to maintain required curvature and other alignment checks when 
performing geometric layouts. They work at two levels:  
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• Provide values for the element creation tools (for example, minimum radius and transition 
lengths)  

• Check the suitability of complex elements (for example, check for kinks in the alignment)  
Design standards are very alignment oriented. You may find limited value in using design 
standards for non-alignment computations.  
When a design standard is violated, feedback is provided in two ways:  

• An icon in the graphics on the element that has the problem. Hover over the icon to reveal 
a tooltip report of the error.  

• In the Civil Message Center” 
• Inputs 

o Design Type (New Pavement, Overlay, Restoration, or Rehabilitation) 
o Pavement Type (JPCP or CRCP) 
o Concrete Layers & Thickness 
o Layers & Thickness 
o Base Thickness 
o Sub-base Thickness 
o Material Properties 

According to 2013 Indiana Design Manual, INDOT 2022 Standard Specifications, and Bentley 
Education (2023), concrete pavement model was developed following the process in Figure B.13.  
 

 
Figure B.13 Process for “openroads designer.” 

B.3 Setup and Installation of the “OpenRoads Designer” Software 

The software created this model: OpenRoads Designer CE - 2022 Release 1.  
The link for downloading the software:  
https://softwaredownloads.bentley.com/en/ProductDetails/2515?data=onRI2lTeYEZmEca3Zgxp
PqjBBQaDUqVyu3ksyqyqDoTXhdaKslC8HjtKqOTu0A35rW6y5HLN7BQ%3D 
 
After downloading “OpenRoads Designer CONNECT Edition,” as shown in Figure B.14. Then 
click on Setup_OpenRoadsDesignerx64_10.11.00.115 to start the installation of the software. 
 

WorkSpace and WorkSets

Terrain

Geometry

Templates

Corridors

Cross Sections and Earthwork Quantities
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Figure B.14 Download the software. 

We should configure the software to change the installation options, select “Configure,” as shown 
in Figure B.15. 
 

 
Figure B.15 Interface in the start: installation of the software. 
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We can select “GenerativeComponents,” then click next. 
 

 
Figure B.16 Interface for the “application install location” and “companion features.” 

Select the option “custom configuration (plus delivered configuration),” as shown in Figure 
B.17. Browse to select the folder where the “custom configuration” will be located, then click 
next. 
 

 
Figure B.17 Interface for the type of configuration. 
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Click Done to finalize the choices, as shown in Figure B.18. 

 
Figure B.18 Interface for the “features.” 

Choose “I accept the End User License Agreement” and then click “Install,” as shown in Figure 
B.19, to start installation processes. 
 

 
Figure B.19 Install the software. 
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B.4 Create OpenRoads Model (Step by Step) 

First Step: Launch INDOT Connect for OpenRoads Designer, create a workspace, worksets, 
and create files. 
Set OpenRoads Model 

1. Create New WorkSpace. 
2. Create New WorkSet. 
3. Create New (*dgn) file. 

• Select the WorkSpace & WorkSet, as shown in Figures B.20 to B.31, in OpenRoads Designer 
using a file (*dgn). 

•  

 
Figure B.20 Create new “workspace.” 
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Figure B.21 Define the name and description for new “workspace” as “INDOT_2023.” 

 

 
Figure B.22 Create new “workset.” 
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Figure B.23 Select “create workset.” 

 

 
Figure B.24 Interface for “create workset” dialog. 
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Figure B.25 Define the name and description for new “workset” as “INDOT_2023.” 

 
• Create New File: New File>File Name>Browse>Seed2D - Imperial Design 
Notes:  

o When we create a new file, we should choose “Seed”: Click “Browse” and check that the 
Seed is: “Seed2D - Imperial Design.dgn” 

(Configuration\Organization-Civil\_Civil Default Standards - Imperial\Seed\Seed2D - Imperial 
Design.dgn) 

o Save the file as “DGN Files (*.dgn)” type 

 
Figure B.26 Create a “New file.” 
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Figure B.27 Files for “standards-imperials” “seed.” 

 
Imperial System Units 
 
• Length/Distance 

o Inches (in) 
o Feet (ft) 
o Yard (yd) 
o Mile (mi) 

• Imperial System Conversion 
o 1 ft = 12 in 
o 1 yd = 3 ft 
o 1 yd = 36 in 
o 1 mile = 1760 yards 

• Imperial System to Metric 
o 1 in = 2.54 cms 
o 1 ft = 30.48 cms 
o 1 yd = 91.44 cms 
o 1 yd = 0.9144 m 
o 1 mile = 1609.34 m 
o 1 mile = 1.6 kms 
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Figure B.28 Interface for the “file save,” click on “browse” to select the seed file. 

 

 
Figure B.29 Seed files. 
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Figure B.30 Define the “file name.” 

 

 
Figure B.31 Interface for the “new file.” 
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Notes: To start working on the pavement roads, please check that “OpenRoads Modeling” is 
selected, as shown in Figure B.32. 
 

 
Figure B.32 Interface for selecting “OpenRoads Modeling.” 

 
Second Step: 2D Design Geometrics Alignments - According to (INDOT, 2022a). 
Create feature definition: from geometry tab choose “Standards,” as shown in Figure B.33 to 
Figure B.38. 
• Standards: (Geometry Tab>Standards>Feature Definition 

Toolbar>Alignment>Road>Geom_Baseline) 

 
Figure B.33 Select “standards.” 
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Figure B.34 Select “feature definition toolbar.” 

 

 
Figure B.35 Interface for the “feature definition toggle toolbar.” 
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Figure B.36 Select the feature definition. 

 

 
Figure B.37 Select the “geom_baseline” as a feature definition. 
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Figure B.38 Make active the “geom_baseline” as a feature definition. 

 
Third Step: 2D Design Geometrics Alignments—according to (INDOT, 2022c). 

• Create horizontal tangent elements: Attach tools (geometry and terrain) as references, as 
shown in the following steps. 

 
Create horizontal tangent elements and terrain (Go to Home Tab>Attach Tools> References> 
References Interface>Tools>Attach). 

 
Figure B.39 Interface for selecting the “references.” 
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Figure B.40 Interface for selecting the “references” by using “attach tools.” 

 

 
Figure B.41 References dialog. 
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Figure B.42 From tools tab choose “attach.” 

 
Notes: We can attach the file adapted from the (\ORD Documents - 2023\QuickStart for 
Geometry – Road) (located in the \References folder in the companion digital package). 
 

 
Figure B.43 Select “aerial_topo” as a reference for geometry. 
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Figure B.44 Check the “attachment method” is “coincident world.” 

 

 
Figure B.45 Approve the import of an “aerial_topo” as a reference. 
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Figure B.46 Interface for the geometry shape. 

 
• Create horizontal tangent and curves and alignment. 

Steps to draw the profile line: Geometry Tab>Lines> Line Between Points 
 

 
Figure 1.47 Identify the “line between points” to start drawing the profile. 
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Figure B.48 Check the details of the line from “line” dialog. 

 

 
Figure B.49 To start from the center of the circle, select “center snap.” 
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Figure B.50 Start to draw the line. 

 

 
Figure B.51 Complete the line for all points. 

 

B-31



 
Figure B.52 Select the line to check the details. 

 

 
Figure B.53 For reviewing all details, select the “properties.” 
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Figure B.54 The properties for the line. 

 

 
Figure 2.55 Export the “horizontal geometry report.” 
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Figure B.56 Interface for the “horizontal geometry report.” 

 
• Draw the arc between the elements: Geometry Tab>Arcs> Arc Between Elements>Simple 

Arc 
 

 
Figure B.57 Draw a simple arc between elements. 
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Figure B.58 Select the first element. 

 

 
Figure B.59 Select the second element. 
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Figure B.60 Define the appropriate radius. 

 
Left click to accept that. 
 

 
Figure B.61 Trim/extend option (both). 

Left click to accept that. 
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Figure B.62 Complete the arc between all pairs of two elements. 

 
Identify the line as a “complex geometry” to define all lines and arcs as a one line (one element): 
Geometry Tab>Complex Geometry> Select the line. 
 

 
Figure B.63 Choose the “complex geometry.” 
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Figure B.64 Select the first element and check the arrow direction. 

 

 
Figure B.65 “Accept complex.” 

Right click to accept that. 
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Figure B.66 Interface for the line as a “complex element.” 

 
Identify the start station (0.00): Geometry Tab>Modify>Start Station 
 

 
Figure B.67 Choose the “start station.” 
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Figure B.68 Select the element (line). 

 

 
Figure B.69 Define the start station position. 
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Figure B.70 Interface for the details of the station point and the line. 

 

 
Figure B.71 Interface for the final details of the line. 
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Attach tools (Geometry and Terrain) as references: Home Tab>Attach Tools> References> 
References interface>tools>Attach>Select Terrain_Existing 
 

 
Figure B.72 Choose the “references” from “attach tools” list. 

 

 
Figure B.73 References dialog. 
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Figure B.74 Select “attach” from “tools” list. 

 

 
Figure B.75 Select “terrain existing” and check “attachment method” as a “coincident world.” 
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Figure B.76 Interface for the “references” dialog after adding a new reference. 

 
Close the interface. 
 

 
Figure B.77 Interface for the terrain and geometry. 
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Figure B.78 Interface for the final shape of the terrain and geometry. 

 

 
Figure B.79 Click on the edge of the terrain to show the “properties.” 
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Figure B.80 Click on the terrain to active it—“Set as Active Terrain Model.” 

 

 
Figure B.81 Properties of the terrain. 

Notes: Please select “Yes” to show and control for all features for terrain, then start to show any 
features (On/Off) as following. 

• Users need to click on the Reference>Override Symbol>change from “No” to “Yes.” 
• The Calculated Features Display window’s optional arrows (On/Off) will be activated.  
• Change the needed options from Off to On. 
• The Contours of the terrain will show. 
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Figure B.82 To show the contours of the terrain. 

 

 
Figure B.83 Contours of the terrain. 
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Figure B.84 Interface for the terrain and the line. 

 
Define Annotation to show more details for the profile (Annotations Scale 1″ = 100′) 
Drawing Production Tab>Annotations>Annotate Element 
 

 
Figure B.85 select the “annotations scale” (1″ = 100′). 
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Figure B.86 Select the “annotate element.” 

 

 
Figure B.87 Select the profile. 

Left click to accept. 
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Figure B.88 Interface for the terrain and profile. 

 

 
Figure B.89 Interface for more details of the profile. 
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If you want to show 2D and 3D view: Right-click >View Control>2 Views Plan/3D. 
 

 
Figure B.90 Interface to show the two views “Plan/3D.” 

 
Fourth Step: Define Profile Model View 

Home Tab>Element Selection>Select the element>Open Profile Model 

 
Figure B.91 Select the “element selection.” 
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Figure B.92 Select the profile. 

 

 
Figure B.93 Select the icon of “open profile model.” 
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Figure B.94 Select the “open view.” 

 

 
Figure B.95 Select the “view toggles” to show the view for the profile. 
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Figure B.96 Interface for the views of 2D and profile. 

 
Notes: If the profile does not appear, please double click in the interface. 
 

 
Figure B.97 Interface for the views of 2D and profile. 
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Figure B.98 Click on the profile to show the details. 

 
Create and edit vertical geometry (draw the profile): Geometry Tab>Vertical>Lines>Profile Line 
between Points 
 

 
Figure B.99 Select the line from vertical icons. 
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Figure B.100 Select the “profile line between points.” 

 

 
Figure B.101 Start to draw the vertical line “enter start point.” 

 
Notes: Please check that we use the feature definition is “Use Active Feature” and the feature 
name.  
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Figure B.102 Complete the line according to length and slope. 

 

 
Figure B.103 To continue the line, “chain commands” icon should be active. 

 
Please make sure to complete the line! 
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Figure B.104 Complete the profile. 

 
Create and edit vertical geometry (Draw the arc between lines): Geometry 
Tab>Vertical>Curves>Profile Curve Between Elements> Parabola between Elements 
 

 
Figure B.105 Select the curve icon. 
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Figure B.106 Select the “parabola between elements.” 

 

 
Figure B.107 Start to draw the parabola between elements (select the first element). 
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Figure B.108 Start to draw the parabola between elements (select the second element). 

 

 
Figure B.109 Start to draw the parabola between elements (identify the length). 
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Figure B.110 Start to draw the parabola between elements (trim/extend). 

 
Please remember to Left-Click to accept! 
 

 
Figure B.111 Select the “profile complex by elements.” 

 
Note: The method in the (complex dialogue) should be as “automatic.” 
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Figure B.112 “Locate first element.” 

 
Note: After that please left click to “accept.” 
 

 
Figure B.113 Set the profile “as active profile”—details for slope and length of profile. 
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Figure B.114 Set the profile “as active profile.” 

 
Vertical report (left click on profile>profile report). 
 

 
Figure B.115 Show the “profile report.” 
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Figure B.116 Interface for “vertical profile report.” 

 

 
Figure B.117 Interface for the final profile. 

 
Right-click on the screen “View 1.” 
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Figure B.118 Interface for the “view control” to show “3 views.” 

 

 
Figure B.119 Interface for 2D/3D/Profile. 

 
Fifth Step: Typical Section (Concrete Pavement). 
Corridors and Cross-section: According to INDOT Standards and Design Manual, we created 
the following cross sections (Corridors> Create>Template> Create Template): 

• Concrete pavement sections with concrete curb (4 in.). 
• Concrete pavement sections with concrete curb (6 in.). 
• Concrete pavement sections with full-depth concrete shoulder (4 in.). 
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• Concrete pavement sections with full-depth concrete shoulder (6 in.). 
o PCCP Section with PCC Shoulder: Detailing full-depth concrete pavement sections 

with full-depth concrete shoulder. 

 
Figure B.120 Cross-section details for PCCP section with PCC shoulder (INDOT, 2022a).  

 
o PCCP with Concrete Curb: Detailing full-depth concrete pavement sections with 

concrete curb. 

 
Figure B.121 Cross-section details for PCCP section with concrete curb (INDOT, 2022a).  
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Create Cross-Section: Corridors Tab>Create>Template>Create 
Template>File>Open>Template-Imperial 
 
(C:\ProgramData\Bentley\OpenRoads Designer CE 10.11\Configuration\Organization-
Civil\_Civil Default Standards - Imperial\Template Library)> OpenRoads Templates Imperial.itl 
Notes: The file depends on the default installation of the software. In the companion digital 
package it is located in “Configuration\Organization-Civil\_Civil Default Standards - 
Imperial\Template Library” 
 

 
Figure B.122 Select “create template.” 
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Figure B.123 Interface for “create template.” 

 

 
Figure B.124 Select “open” to choose the templates. 
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Figure B.125 Choose “templates-imperial.itl.” 

 
Note: In the cross-section template: When we create a new template for cross-section, we should 
choose “OpenRoads Templates Imperial.” 
 
Corridors and Cross-Section: According to INDOT Standards and Design Manual, we created the 
following cross sections (Corridors> Template> Create Template): 

• Concrete pavement sections with concrete curb (4 in.) 
• Concrete pavement sections with concrete curb (6 in.) 
• Concrete pavement sections with full-depth concrete shoulder (4 in.) 
• Concrete pavement sections with full-depth concrete shoulder (6 in.) 

• PCCP Section with PCC Shoulder: Detailing full-depth concrete pavement 
sections with full-depth concrete shoulder. 

 

 
Figure B.126 Details for the cross section (4 in.). 
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Figure B.127 Details for the cross section (6 in.). 

 

 
Figure B.128 Interface for the “create template”—“template library.” 
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Figure B.129 Example for the “concrete w/ curbs” template. 

 

 
Figure B.130 Right-click on the “template” to create new folder. 
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Figure B.131 Create new folder “INDOT.” 

 

 
Figure B.132 Copy and paste samples from “template” for “concrete w/ curbs” and “concrete 

pavt w/ concrete shoulder.” 
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Save As: File>Save As 
 (C:\ProgramData\Bentley\OpenRoads Designer CE 
10.11\Configuration\WorkSpaces\INDOT_2023\WorkSets\INDOT_2023\Standards\Template 
Library\ INDOT Templates - Imperial) 
 

 
Figure B.133 Select “save as.” 

 

 
Figure B.134 Create name for the template according to the project. 
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Create Template “Typical Section.” 
From “Components,” we can copy the samples (2 Lanes Curbs and 2 Lanes Shoulders) for the 
templates and then edit it according to the details and specifications of the project. 
 

 
Figure B.135 Check the details for the points. 

Double click. 
 

 
Figure B.136 Interface for the “point properties” and from this dialog we can edit the details for 

the point. 
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Figure B.137 Define the constraints for the point (constraints 1). 

 

 
Figure B.138 Define the constraints for the point (constraints 2). 
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Figure B.139 Details for the point. 

 

 
Figure B.140 Details for the second point between the concrete layer and aggregate layer. 

 
Also, continue to check all points.  Then double-click on the shape for the first layer. 
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Figure B.141 Click on the edge of first layer to show the details of “component properties.” 

 

 
Figure B.142 Dialog for the “component properties”—aggregate layer details. 

 

B-77



 
Figure B.143 Click on “classifications” to show “classification properties.” 

 

 
Figure B.144 Dialog for the “classification properties.” 
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Figure B.145 Dialog for the “classification properties” and set the main classification as “is 

pavement.” 

 
The second layer: 
 

 
Figure B.146 Click on the second layer to show the details of “component properties.” 
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Figure B.147 Dialog for the “component properties”—aggregate layer details. 

 

 
Figure B.148 Dialog for the “classification properties.” 
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For curbs: 
 

 
Figure B.149 Dialog for the curb details. 

Then add the third layer. 
Right Click> Add New Component>Simple 
 

 
Figure B.150 Select “add new component.” 
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Figure B.151 Start to add layers. 

 

 
Figure B.152 Details for the new layer. 
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Figure B.153 Complete the process for adding the new layer. 

 

 
Figure B.154 Check the new layer. 

 
Then complete by the same steps. 
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Figure B.155 Interface for the template “concrete pavement sections with concrete curb.” 

 
Copy and paste to edit the cross section for 6 in. 
 

 
Figure B.156 Copy the new template. 
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Figure B.157 Paste the template. 

Apply the same steps with the cross-section of concrete/shoulders. 
 

 
Figure B.158 Samples for the concrete with shoulder. 
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Figure B.159 Interface for the INDOT templates. 

 
Notes: In this model, we set the thickness of the concrete pavement (4 in.) in 0.35 ft., the thickness 
of the concrete pavement (6 in.) in 0.5 ft., the 1st layer of aggregate is 0.35 ft., and the 2nd layer 
of aggregate is 0.5 ft, as shown in Figure B.128 to Figure B.133. 
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Figure B.160 2nd point (value 0.500) for (6 in.). 

 
Figure B.161 3rd point (value 0.350) for (4 in.). 
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Figure B.162 4th point (value 0.500) for (6 in.). 

 

 
Figure B.163 2nd point (value 0.350) for (4 in.). 
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Figure B.164 3rd point (value 0.350) for (4 in.). 

 
Figure B.165 4th point (Value 0.500) for (6 in.). 
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To make a copy of the template library (Use the template library organizer to manage templates 
across the library files). 
 
Tools>Template Library Organizer 
 

 
Figure B.166 Interface for the template “concrete pavement sections with full-depth concrete 

shoulder.” 

Open another dialog: 
 

 
Figure B.167 Interface for the “template library organizer.” 
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Figure B.168 Copy the new folder to insert INDOT file as “active design file corridors.” 

 
Figure B.169 Select the icon in the active folder to insert INDOT file as “available in: “active 

design file corridors.” 
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Figure B.170 Save the new template. 

 
Sixth Step: Create Corridor 3D Model! 
Notes: Check the Terrain and the profile “As Active” then “Create Corridor.” 
Corridors Tab>New Corridor>Feature Definition (Corridor/Road/Final)>select the profile>select 
the template. 
 

 
Figure B.171 Set the terrain as active. 
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Figure B.172 Select the profile to check the details. 

 

 
Figure B.173 Select “new corridor.” 
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Figure B.174 Select the “feature definition” as “final.” 

 

 
Figure B.175 “Locate corridor baseline.” 

 
Click on the profile. 
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Figure B.176 Locate profile for the active profile. 

 
Right click to accept that. 

 

 
Figure B.177 Confirm for the feature name. 

Left click to accept that. 
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Figure B.178 To select the template, click on the icon of “template.” 

 
Then, identify the Template. 
 

 
Figure B.179 Interface for the template that was selected. 
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Figure B.180 Choose the suitable template. 

 

 
Figure B.181 Confirm the template that was selected. 

 
Left click to accept that. 
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Figure B.182 Select the “start station.” 

 

 
Figure B.183 Select the “end station.” 
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Figure B.184 Check “drop interval.” 

Left click to accept that. 
 

 
Figure B.185 Interface for the 2D and 3D model. 
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• Cross-Section View (Corridors>Dynamic Sections>Open Cross Section View) 
 

 
Figure B.186 Open cross-section view. 

 

 
Figure B.187 Select the corridor. 
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Figure B.188 Select “open view.” 

 

 
Figure B.189 Select “View toggles.” 
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Figure B.190 Select the corridor from “view 1.” 

 

 
Figure B.191 Select the “open view” in “view 7.” 

 

B-102



 
Figure B.192 Interface for the “cross section.” 

 

 
Figure B.193 Display the details from “view properties” in the “view 7” dialog. 
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Figure B.194 Interface for the details of the cross section. 

 
 
Quantities report: (Home Tab>Corridor Reports>Component Quantities). 
 

 
Figure B.195 Interface for selecting the “component quantities.” 
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Figure B.196 “Locate Corridor.” 

 

 
Figure B.197 Interface for the “component quantities report.” 
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Figure B.198 Select the report to show. 

 
Figure B.199 Interface for “component quantities.” 
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Figure B.200 Interface for “component quantities summary report.” 

 
Exported IFC Format from OpenRoads Designer (ORD). 
 
B.4.1 First Step: To export alignments from the ORD file to IFC format 
 
Geometry Tab>General Tools>Import/Export>Export Geometry> ExportType> select 
IFCAlignment> Confirm IFCAlignment 

 
Figure B.201 Interface to export the geometry. 
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Figure B.202 Select the “Export Type” as “IFC Alignment.” 

 
Figure B.203 Confirm the “Export Type” as “IFC Alignment.” 

 
Left click. 
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Figure B.204 Confirm for the “locate elements.” 

Right click. 
 

 
Figure B.205 Save the file. 

Note: Repeat this step with the different templates. 
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B.4.2 Second Step: To export the design model from the ORD file to IFC format 
Home Tab>Model Import/Export> Export to IFC>select IFC Version 
 

 
Figure B.206 Export to IFC. 

 
Figure B.207 Interface to select the “IFC Version.” 
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Figure B.208 Select IFC4 as the “IFC Version.” 

 
Figure B.209 Left-Click on the profile in “View 1.” 
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Figure B.210 Save the file. 

Note: Repeat these steps with the other IFC Version and different templates. 
 
B.4.3 Third Step: IFC Format 
Notes: Using a BIM visualization tool (e.g., BIMvision) to open the file as “IFC”, as shown 
below.  
Right-Click>Open with> BIMvision – freeware IFC viewer 

 
Figure B.211 Right-click on the icon. 
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Figure B.212 Interface for reading and loading the file. 

 

 
Figure B.213 Interface for the IFC view. 
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On March 11, 1937, the Indiana Legislature passed an act which authorized the Indiana State 
Highway Commission to cooperate with and assist Purdue University in developing the best 
methods of improving and maintaining the highways of the state and the respective counties 
thereof. That collaborative effort was called the Joint Highway Research Project (JHRP). In 1997 
the collaborative venture was renamed as the Joint Transportation Research Program (JTRP) 
to reflect the state and national efforts to integrate the management and operation of various 
transportation modes. 

The first studies of JHRP were concerned with Test Road No. 1 — evaluation of the weathering 
characteristics of stabilized materials. After World War II, the JHRP program grew substantially 
and was regularly producing technical reports. Over 1,600 technical reports are now available, 
published as part of the JHRP and subsequently JTRP collaborative venture between Purdue 
University and what is now the Indiana Department of Transportation. 

Free online access to all reports is provided through a unique collaboration between JTRP and 
Purdue Libraries. These are available at http://docs.lib.purdue.edu/jtrp. 

Further information about JTRP and its current research program is available at
http://www.purdue.edu/jtrp. 
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An open access version of this publication is available online. See the URL in the citation below. 
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